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Department-CE

KCT College of Engineering and Technology

EXPERIMENT NO. 1:-

DRAW COMMANDS
LINE

/

Button
# Ribbon: Home tab » Draw panel » Line

£ Toolbar; Draw /

B Command entry: line
Specify first point: Specify a point or press ENTER to continue from the last drawn line or arc

Specify next point or [Close/Undo]:

Continue
Continues a line from the endpoint of the most recently drawn line.

|
|
before pressing ENTER after pressing ENTER
Close
Ends the last line segment at the beginning of the first line segment, which forms a closed loop

of line segments. You can use Close after you have drawn a series of two or more segments.

|'I \ |1|‘ \\\\3

|
!
after entering

before entering

Undo
Erases the most recent segment of a line sequence.

before entering after entering
Entering # more than once backtracks through line segments in the order you created them.
With LINE, you can create a series of contiguous line segments. Each segment is a line object that

can be edited separately.
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1 2
x X
\3
X
POLYGON
(7
| M
Button
¥ Ribbon: Home tab » Draw panel » T  » Polygon
)

® Toolbar: Draw '—/

E Command entry: polygon
Enter number of sides <current>: Enter a value between 3 and 1024 or press ENTER
Specify center of polygon or [Edge]: Specify a point (1) or enter e

polygons

Center of Polygon

Defines the center of the polygon.

Enter an option [Inscribed in circle/Circumscribed about circle] <current>: Enter i or c or press
ENTER

Inscribed in Circle

Specifies the radius of a circle on which all vertices of the polygon lie.

Specify radius of circle: Specify a point (2) or enter a value

radius '
Specifying the radius with your pointing device determines the rotation and size of the polygon.
Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation
angle.
Circumscribed about Circle
Specifies the distance from the center of the polygon to the midpoints of the edges of the polygon.
Specify radius of circle: Specify a distance
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e

radius—

Specifying the radius with your pointing device determines the rotation and size of the polygon.
Specifying the radius with a value draws the bottom edge of the polygon at the current snap rotation
angle.

Edge

Defines a polygon by specifying the endpoints of the first edge.

Specify first endpoint of edge: Specify a point (1)

Specify second endpoint of edge: Specify a point (2)

.
.

1 P
Edge )‘--.___‘.. .-_____..-

2
You can specify the different parameters of the polygon including the number of sides. The
difference between the inscribed and circumscribed options is shown.

2 2
s ey /=Xy
1 \ A N\
| c b} Q *1 )
\ ) \ /
RECTANGLE
Button

% Ribbon: Home tab » Draw panel » Rectangle

£ Toolbar: Draw D

B Command entry: rectang or rectangle

Current settings: Rotation =0

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: Specify a point or enter an
option

With this command, you can specify the rectangle parameters (length, width, rotation) and control

1
X

the type of corners (fillet, chamfer, or square).
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First Corner Point

Specifies a corner point of the rectangle.

Specify other corner point or [Area/Dimensions/Rotation]: Specify a point or enter an option
Other Corner Point

]

Creates a rectangle using the specified points as diagonally opposite corners.

Area

Creates a rectangle using the area and either a length or a width. If the Chamfer or Fillet option is
active, the area includes the effect of the chamfers or fillets on the corners of the rectangle.

Enter area of rectangle in current units <100>: Enter a positive value

Calculate rectangle dimensions based on [Length/Width] <Length>: Enter L or w

Enter rectangle length <10>: Enter a non-zero value

or

Enter rectangle width <10>: Enter a non-zero value

Specify other corner point or [Area/Dimensions/Rotation]: Move the cursor to display one of four
possible locations for the rectangle and click the one that you want

Dimensions

Creates a rectangle using length and width values.

Specify length for rectangles <0.0000> Enter a non-zero value

Specify width for rectangles <0.0000> Enter a non-zero value

Specify other corner point or [Area/Dimensions/Rotation]: Move the cursor to display one of four
possible locations for the rectangle and click the one that you want

Rotation

Creates a rectangle at a specified rotation angle.

Specify rotation angle or [Points] <0> Specify an angle by entering a value, specifying a point, or
entering p and specifying two points

Specify other corner point or [Area/Dimensions/Rotation]: Move the cursor to display one of four
possible locations for the rectangle and click the one that you want

Chamfer

Sets the chamfer distances for the rectangle.

Specify first chamfer distance for rectangles <current>: Specify a distance or press ENTER
Specify second chamfer distance for rectangles <current>: Specify a distance or press ENTER
The values become the current chamfer distances for subsequent RECTANGLE commands.
Elevation

Specifies the elevation of the rectangle.

Specify the elevation for rectangles <current>: Specify a distance or press ENTER

The value becomes the current elevation for subsequent RECTANGLE commands.

Fillet

Specifies the fillet radius of the rectangle.

Specify fillet radius for rectangles <current>: Specify a distance or press ENTER

The value becomes the current fillet radius for subsequent RECTANGLE commands.

Thickness
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Specifies the thickness of the rectangle.

Specify thickness for rectangles <current>: Specify a distance or press ENTER

The value becomes the current thickness for subsequent RECTANG commands.
Width

Specifies the poly-line width of the rectangle to be drawn.

Specify line width for rectangles <current>: Specify a distance or press ENTER

The value becomes the current poly-line width for subsequent RECTANG commands.

CIRCLE

@

Button
% Ribbon: Home tab * Draw panel > Circle drop-down > Center, Radius.

£ Toolbar: Draw @

& Command entry: circle
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: Specify a point or enter an option
Center Point
Draws a circle based on a center point and a diameter or a radius.
Specify radius of circle or [Diameter]: Specify a point, enter a value, enter d, or press Enter
Radius
Defines the radius of the circle. Enter a value, or specify a point.

\K W/
— 2
radius
Diameter

Defines the diameter of the circle. Enter a value, or specify a second point.

diameter

Specify diameter of circle <current>: Specify a point (2), enter a value, or press Enter
3P (Three Points)

Draws a circle based on three points on the circumference.

Specify first point on circle: Specify a point (1)

Specify second point on circle: Specify a point (2)

Specify third point on circle: Specify a point (3)

2 |

.__\M ;/f.

3
2P (Two Points)
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Draws a circle based on two endpoints of the diameter.
Specify first endpoint of circle's diameter: Specify a point (1)
Specify second endpoint of circle's diameter: Specify a point (2)

/ N

[ |
\ |
N ,/;
op =" 2

TTR (Tangent, Tangent, Radius)
Draws a circle with a specified radius tangent to two objects.
Specify point on object for first tangent of circle: Select a circle, arc, or line
Specify point on object for second tangent of circle: Select a circle, arc, or line
Specify radius of circle <current>:
N

' |

NIANG

tan, tan, radiuss

Sometimes more than one circle matches the specified criteria. The program draws the circle of the
specified radius whose tangent points are closest to the selected points.

N N
\ A /)
1O ~
ELLIPSE
<
Button
® Ribbon: Home tab * Draw panel * Ellipse drop-down * Center

® Toolbar: Draw R‘:'}
E Command entry: ellipse
Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: Specify a point or enter an option
The first two points of the ellipse determine the location and length of the first axis. The third point

determines the distance between the center of the ellipse and the end point of the second axis.

: 3
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Axis Endpoint

Defines the first axis by its two endpoints. The angle of the first axis determines the angle of the
ellipse. The first axis can define either the major or the minor axis of the ellipse.

Specify other endpoint of axis: Specify a point (2)

Specify distance to other axis or [Rotation]: Specify a distance by entering a value or locating a point
(3), or enter r

Arc

Creates an elliptical arc.

The first two points of the elliptical arc determine the location and length of the first axis. The third
point determines the distance between the center of the elliptical arc and the endpoint of the second
axis. The fourth and fifth points are the start and end angles.

1

)(5 XZ

The angle of the first axis determines the angle of the elliptical arc. The first axis can define either

the major or the minor axis depending on its size.
Specify axis endpoint of elliptical arc or [Center]: Specify a point or enter ¢
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EXPERIMENT NO. 2:-
EDIT COMMANDS
ERASE:-

&

Button
» Ribbon: Home tab * Modify panel * Erase

% Toolbar: Modify = —
Shortcut menu: Select the objects to erase, right-click in the drawing area, and click Erase.

E Command entry: erase
Select objects: Use an object selection method and press Enter when you finish selecting objects
The objects are removed from the drawing.

T |

-+ + = —_— —
object selected object erasad

Instead of selecting objects to erase, you can enter an option, such as L to erase the last object drawn,
p to erase the previous selection set, or ALL to erase all objects. You can also enter ? to get a list of
all options.

L S =1 E

O

WA A
] d
3 ]
AN

d -
j F=W=r=.

COPY:-
O3
Q
Button % Ribbon: Home tab * Modify panel * Copy
O
Q)

® Toolbar: Modify
Shortcut menu: Select the objects to copy, and right-click in the drawing area. Click Copy Selection.
E Command entry: copy
Select objects: Use an object selection method and press Enter when you finish
Current settings: Copy mode = current
Specify base point or [Displacement/mOde/Multiple] <Displacement>: Specify a base point or enter
an option
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The two points you specify define a vector that indicates how far the copied objects are to be moved
and in what direction.
If you press Enter at the Specify Second Point prompt, the first point is interpreted as a relative X,Y,Z
displacement. For example, if you specify 2,3 for the base point and press Enter at the next prompt,
the objects are copied 2 units in the X direction and 3 units in the Y direction from their current
position.
The COPY command repeats automatically by default. To exit the command, press Enter. With the
COPYMODE system variable, you can control whether multiple copies are created automatically.

3

1 m=e
p oI j
—a) o N —

lg=o
S

MIRROR:-

A

Button
£ Ribbon: Home tab *» Modify panel * Mirror

% Toolbar: Modify ’d ‘ B

& Command entry: mirror
Select objects: Use an object selection method and press Enter to finish
Specify first point of mirror line: Specify a point
Specify second point of mirror line: Specify a point

2
@ r@ ) ||’F5\II (o
e ) _F/-'\.
objects selected 1

The two specified points become the endpoints of a line about which the selected objects are
mirrored. For mirroring in 3D, this line defines a mirroring plane perpendicular to the XY plane of the
user coordinate system (UCS) containing the mirror line.
Erase source objects? [Yes/No] <N>: Enter y or n, or press Enter
Yes
Places the mirrored image into the drawing and erases the original objects.
No
Places the mirrored image into the drawing and retains the original objects.
g

original objects

retained
You can create objects that represent half of a drawing, select them, and mirror them across a
specified line to create the other half.
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-~ ~ - 7‘ : ~ ~ | 2
OFFSET:-
Button

% Ribbon: Home tab » Modify panel > Offset

A
2 Toolbar: Modify =
E Command entry: offset
Current settings: Erase source = current Layer = current OFFSETGAPTYPE = current
Specify offset distance or [Through/Erase/Layer] <current>: Specify a distance, enter an option, or
press Enter
( -
M Ry

\ N
polyling palyline with
offset

You can offset an object at a specified distance or through a point. After you offset objects, you can
trim and extend them as an efficient method to create drawings containing many parallel lines and
curves.

T

2

o = e T —

’ 1
The OFFSET command repeats for convenience. To exit the command, press Enter.
Offset Distance
Creates an object at a specified distance from an existing object.
Select object to offset or [Exit/Undo] <exit>: Select one object, enter an option, or press Enter to end
the command
Specify point on side to offset or [Exit/Multiple/Undo] <exit or next object>: Specify a point (1) on
the side of the object you want to offset or enter an option
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TEE | M

offset distance o
il | T
object selected side selected object offsed
Exit
Exits the OFFSET command.
Multiple

Enters the Multiple offset mode, which repeats the offset operation and accepts additional through
points.

EXTEND:-
—/

Button
¥ Ribbon: Home tab * Modify panel * Trim and Extend drop-down * Extend
¥ Toolbar: Modify
B Command entry: extend

ARRAY:-

Select objects: Use an object selection method

Enter the type of array [Rectangular/Polar] <current>: Enter an option or press ENTER
Rectangular

Creates an array of rows and columns of copies of the selected objects.

Enter the number of rows (---) <1>:Enter a nonzero integer or press ENTER

Enter the number of columns (|||) <1>:Enter a nonzero integer or press ENTER

O00 Gl|_r
O D D Cul—L '-dg:nce between

| |
1|D

e omf

abject selected | distance between columns

If you specify one row, you must specify more than one column and vice versa.
The selected object, or cornerstone element, is assumed to be in the lower-left corner, and generates
the array up and to the right.
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The specified distance between the rows and columns includes the corresponding lengths of the
object to be arrayed.

Enter the distance between rows or specify unit cell (---):

To add rows downward, specify a negative value for the distance between rows. ARRAY skips the
next prompt if you specify two points for the opposite corners of a rectangle.

Specify the distance between columns (||):

To add columns to the left, specify a negative value for the distance between columns. Rectangular
arrays are constructed along a baseline defined by the current snap rotation. This angle is normally 0,
so the rows and columns are orthogonal with respect to the X and Y drawing axes. The Rotate option
of the SNAP command changes the angle and creates a rotated array. The SNAPANG system
variable stores the snap rotation angle.

If you specify a large number of rows and columns for the array, it might take a while to create the
copies. By default, the maximum number of array elements that you can generate in one command is
100,000. The limit is set by the MAXARRAY setting in the registry. To reset the limit to 200,000,
for example, enter (setenv "MaxArray"” "200000") at the Command prompt.

Polar

Creates an array by copying the selected objects around a specified center point.

G 1

o080
O LB

polar array with objects polar array angle to
redated fill=180; objects not
rotated

Specify center point of array or [Base]: Specify a point or enter b to specify a new base point
Center Point

Creates an array defined by a center point.

Base

Specifies a new reference (base) point relative to the selected objects that will remain at a constant
distance from the center point of the array as the objects are arrayed.

Specify the base point of objects: Specify a point

Enter the number of items in the array: Enter a positive integer or press ENTER

If you enter a value for the number of items, you must specify either the angle to fill or the angle
between items. If you press ENTER (and do not provide the number of items), you must specify
both.

Specify the angle to fill (+=ccw, -=cw) <360>: Enter a positive integer for a counterclockwise
rotation or a negative integer for a clockwise rotation

You can enter 0 for the angle to fill only if you specify the number of items.

If you specify an angle to fill without providing the number of items, or if you specify the number of
items and enter 0 as the angle to fill or press ENTER, the following prompt is displayed:

Angle between items: Specify an angle

If you specified the number of items and entered 0 as the angle to fill or pressed ENTER, ARRAY
prompts for a positive or negative value to indicate the direction of the array:

Angle between items (+=ccw, -=cw): Enter a positive integer for a counterclockwise rotation or a
negative integer for a clockwise rotation
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ARRAY determines the distance from the array's center point to a reference point on the last object
selected. The reference point used is the center point of a circle or arc, the insertion base point of a
block or shape, the start point of text, and one endpoint of a line or trace.

Rotate arrayed objects? <Y>: Enter y or n, or press ENTER

In a polar array, the reference point of the last object in the selection set is used for all objects. If you
defined the selection set by using window or crossing selection, the last object in the selection set is
arbitrary. Removing an object from the selection set and adding it back forces that

MOVE:-
+
O
+
Button
® Ribbon: Home tab * Modify panel * Move
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+
O+

® Toolbar: Modify +#
Shortcut menu: Select the objects to move, and right-click in the drawing area. Click Move.
E Command entry: move
Select objects: Use an object selection method and press Enter when you finish
Specify base point or [Displacement]<Displacement>: Specify a base point or enter d
Specify second point or <use first point as displacement>: Specify a point or press Enter

ROTATE:-

O

Button
£ Ribbon: Home tab * Modify panel * Rotate

% Toolbar: Modify O

Shortcut menu: Select the objects to rotate, and right-click in the drawing area. Click Rotate.

Command entry: rotate

Current positive angle in UCS: ANGDIR=current ANGBASE=current

Select objects: Use an object selection method and press ENTER when you finish

Specify base point: Specify a point

Specify rotation angle or [Copy/Reference]: Enter an angle, specify a point, enter c, or ente

SCALE:-
]

Button
® Ribbon: Home tab * Modify panel * Scale

% Toolbar: Modify []
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Shortcut menu: Select the objects to scale, and right-click in the drawing area. Click Scale.
EE Command entry: scale
EE To scale an object, specify a base point and a scale factor. The base point acts as the center of
the scaling operation and remains stationary. A scale factor greater than 1 enlarges the object.
A scale factor between 0 and 1 shrinks the object.
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EXPERIMENT NO. 3:-
COORDINATE ENTRY SYSTEM
X,Y, Z:-
Z Axis
+
A

Button
&1 Ribbon: View tab Coordinates panel World

€]
Bl Toolbar: UCS L»

EE Command entry: ucs
Defines a new UCS using one, two, or three points. If you specify a single point, the origin of the current UCS shifts
without changing the orientation of the X, ¥, and Z axes.
Specify point on X-axis or <Accept>: Specify a second point or press Enter to limit input to a single point
If you specify a second point, the UCS rotates around the previously specified origin point such that the positive X
axis of the UCS passes through the point.
Specify point on XY plane or <Accept>: Specify a third point or press Enter to limit input to two points
If you specify a third point, the UCS rotates around the X axis such that the positive Y half of the XY plane of the
UCS contains the point.

Let’s explore how the cursor is related to the coordinates in the drawing.

1. Click the Zoom Extents button located on the navigation bar (the semitransparent vertical bar
under the ViewCube), or enter ZOOM E to adjust your view to show the extents of the drawing
area.

2. Move the cursor around, and notice the left end of the status bar at the bottom of the screen. This is
the coordinate readout, and it displays the coordinates of the cursor’s position.

3. Move the cursor as close to the lower-left corner of the drawing area as you can without it
changing into an arrow. The coordinate readout should be close to 0.0000, 0.0000, 0.0000.

4. Move the cursor to the top-left corner of the drawing area. The readout changes to something close
to 0.0000, 7.0000, 0.0000, indicating that the top of the screen is 7 units from the bottom.

5. Move the cursor one more time to the upper-right corner of the drawing area. The readout still has
a y-coordinate of approximately 7.0000. The x-coordinate now has a value around 10.5.

The drawing area of a new drawing is preset with the lower-left corner of the drawing at the
coordinates 0,0.

Relative Cartesian Coordinates

The Cartesian system of coordinates uses a horizontal (x) component and a vertical (y) component to locate a
point relative to the 0,0 point. The relative Cartesian system uses the same components to locate the point
relative to the last point picked, so it’s a way of telling AutoCAD how far left or right and up or down to
extend a line or to move an object from the last point picked (see Figure 2.14). If the direction is to the left, the
x-coordinate will be negative. Similarly, if the direction is down, the y-coordinate will be negative. Use this
system when you know the horizontal and vertical distances from point 1 to point 2. To enter data using this
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system, use this form: @x,y.
Mext point

+
A \P?

Last point picked
Last point picked a

/ y distance
P1 Py .-

— X - o] ¥ X &r

L

X distance

Y
=Y
Relative Polar Coordinates
This system requires a known distance and direction from one point to the next. Calculating the
distance is straightforward: it’s always positive and represents the distance away from the first point
that the second point will be placed. The direction requires a convention for determining an angle.
AutoCAD defines right (toward three o’clock) as the default direction of the 0° angle. All other
directions are determined from a counterclockwise rotation. On your screen, up is 90°, left is 180°,
down is 270°, and a full circle is 360°. To let AutoCAD know that you’re entering an angle and not a
relative y-coordinate, use the less-than symbol (<) before the angle and after the distance. Therefore,
in the previous example, to designate a point 8 units to the right of the first point, you would enter
@8<0 or simply 8<0 when the Dynamic Input tool is active.
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EXPERIMENT NO. 4:-
OSNAP

Use object snaps to specify precise locations on objects. For example, you can use an object snap to draw a line to
the center of a circle or to the midpoint of a polyline segment.

You can specify an object snap whenever you are prompted for a point. By default, a marker and a tooltip are
displayed when you move the cursor over an object snap location on an object. This feature, called AutoSnapm™,
provides a visual clue that indicates which object snaps are in effect.

® Toolbar: Status bar ~ * Osnap
® Command entry: osnap (or 'osnap for transparent use)
The Object Snaps tab of the Drafting Settings dialog box is displayed.
If you enter -osnap at the Command prompt, the following prompts are displayed.
Current osnap modes: current
Enter list of object snap modes: Enter names of object snap modes separated with commas, or enter
none or off
Object Snap Modes Specify one or more object snap modes by entering the first three
characters of the name. If you enter more than one name, separate the names with commas.

ENDpoint CENter TANgent

MIDpoint NODe NEArest

INTersection QUAdrant PARallel
EXTension INSertion
APParent Intersection PERpendicular
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EXPERIMENT NO.5
QNEW

Starts a new drawing with a selected drawing template file

The behavior of the QNEW command is determined by the STARTUP system variable.

< [ Displays the Create New Drawing dialog box.

= (): Displays the Select Template dialog box (a standard file selection dialog box) or starts the new
drawing using the default drawing template file.

OPEN

P

£ Toolbar: Standard

£ Menu: Application menu ~ * Open * Drawing
E Command entry: open

The Select File dialog box (a standard file selection dialog box) is displayed.

You can open and load a portion of a drawing, including geometry on a specific view or layer. In the
Select File dialog box, click the arrow next to Open and choose Partial Open or Partial Open Read-
Only to display the Partial Open dialog box.

SAVE
Saves the drawing under the current file name or a specified name.

EE Command entry: save
The Save Drawing As dialog box (a standard file selection dialog box) is displayed. Save the drawing
under the current file name, or enter a different file name to save a copy of the drawing under that
name.

SAVE is available only at the Command prompt. The Save option on the File menu or on the
Standard toolbar is QSAVE. If the drawing is named, QSAVE saves the drawing without displaying
the Save Drawing As dialog box. If the drawing is unnamed, the Save Drawing As dialog box is
displayed. Enter a file name to both name and save the drawing
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EXPERIMENT NO.6
LAYERS

=

Button
® Ribbon: Home tab * Layers panel * Layer Properties Manager

== command entry: layer (or 'layer for transparent use)
The Layer Properties Manager is displayed.
If you enter -layer at the Command prompt, options are displayed.

annotations

dimensions
objects

sample layers

Use layers to control the visibility of objects and to assign properties such as color and linetype.
Objects on a layer normally assume the properties of that layer. However, you can override any layer
property of an object. For example, if an object’s color property is set to BYLAYER, the object
displays the color of that layer. If the object’s color is set to Red, the object displays as red,
regardless of the color assigned to that layer.
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EXPERIMENT NO.7
TEXT IN A DRAWING
DTEXT
Button
o] Home tab » Annotation panel » Multiline Text drop-down » Single Line
8! Draw » Text » Single Line Text
&S text

You can use single-line text to create one or more lines of text, where each text line is an independent
object that you can relocate, reformat, or otherwise modify.

The TEXT command creates a single-line text object. It displays a simplified version of the In-Place
Text Editor that consists of a bounding box that is the height of the text and expands as you type.
Right-click to select options on the shortcut menu.

If TEXT was the last command entered, pressing ENTER at the Specify Start Point of Text prompt
skips the prompts for paper height and rotation angle. The text that you enter in the In-Place Text
Editor for single-line text is placed directly beneath the previous line of text. The point that you
specified at the prompt is also stored as the insertion point of the text.

If the DTEXTED system variable is set to 1, text created using TEXT or DTEXT displays the Edit
Text dialog box.

If DTEXTED is set to 2, the In-Place Text Editor is displayed. When creating text, you can click
anywhere in a drawing to create a new text block. You can also use the keyboard to move among text
blocks (for example: for new text created using the TEXT command, you can navigate through text
groups by pressing TAB or Shift+TAB, or edit a group of text lines by pressing ALT and clicking
each text object.)

NoteText that would otherwise be difficult to read (if it is very small, very large, or is rotated) is
displayed at a legible size and is oriented horizontally so that you can easily read and edit it.

You can enter special characters and format text by entering Unicode strings and control codes.

Use -TEXT to honor the TEXTEVAL system variable. DTEXT is the same as TEXT.
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DDEDIT
% Toolbar: Text %

8 Menu: Modify » Object » Text » Edit

Pointing device: Double-click a text object.
Shortcut menu: Select a text object, right-click in the drawing area, and click Edit.

B command entry: ddedit

Select an annotation object or [Undo]

Obiject Selection

Displays the appropriate editing method for the type of text you select:

< When the DTEXTED system variable is set to 0 or 2, text created using TEXT or DTEXT displays the
In-Place Text Editor without the Text Formatting toolbar and the ruler. Right-click to display options.

= Text created using MTEXT displays the In-Place Text Editor.

= Attribute definitions (not part of a block definition) display the Edit Attribute Definition dialog box.

= Feature control frames display the Geometric Tolerance dialog box.

DDEDIT repeats the prompt until you press ENTER to end the command.

Undo

Returns the text or attribute definition to its previous value. You can use this option immediately
after editing.
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MTEXT

A

Button

& ribbon: Home tab > annozation panel » Multilne Text drop-dowa > Multiine Text

& Menu:Draw » Text » Multiline Tax-

?:‘ Toolbar: Dra"."." " l

Pointing device: CoLble-click 2 multiine text object,

E command entry: Mmtext
CLIFENt Te4t 5 yIED CuFrent: = »—|_;l L <currents arnctative, <ouvrehns =
Specify first corme
SpCc IT:.' Oppasl to zornor or | FCigne Austif ,-'I."'| INc Spacin :|— otatio (r'd St f'll C, Ay dth Zolumns |
You can create several paragraphs of text as a single multiline text (mtext) object. With the built-in
editor, you can format the text appearance, columns, and boundaries.
After you specify the point for the opposite corner when the ribbon is active, the MTEXT ribbon
contextual tab displays. If the ribbon is not active, the in-place text editor is displayed.

If you specify one of the other options, or if you enter -mtext at the Command prompt, MTEXT
bypasses the In-Place Text editor and displays additional command prompts.
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EXPERIMENT NO.8

Zoom Commands
Z00OM REALTIME

Q

Button

£ Ribbon: View tab » Mavigate panel » Zoom drop-down » Realtime

8 Menu: View > Zoom > Realtime

¥ Toolbar: Standard %

Shortcut menu: With no objects selected, right-click in the drawing area and choose Zoom to zoom in
real time,

EE command entry: Zoom (or 'zoom for transparent usel

You can change the magnification of a view by zooming in and out, which is similar to zooming in
and out with a camera. Using ZOOM does not change the absolute size of objects in the drawing. It
changes only the magnification of the view.

In a perspective view, ZOOM displays the 3DZOOM prompts.

Z00M ALL

ALL

Zooms to display the entire drawing in the current viewport. In a plan view, All zooms to the grid
limits or current extents, whichever is greater. In a 3D view, ZOOM All is equivalent to ZOOM
Extents. The display shows all objects even if the drawing extends outside the grid.

In the illustration, LIMITS is greater than the extents of the drawing.

-I—.J-—" - - "
e r
\'\_:_/ L @}‘__; |

before ZOOM All after ZOOM All

Because it always regenerates the drawing, you cannot use ZOOM Al transparently.
Z0O0OM PREVIOUS
Zooms to display the previous view. You can restore up to 10 previous views.

E:Z:,Er 3 i:j'fﬂ

; B " = it [
S — 1J ¥ —amnnnn ' -:l-l_r a
g L Ll
original view current view after ZOOM Previous

Note If you change the visual style, the view is changed. If you enter ZOOM Previous, it restores the
previous view, which is shaded differently but not zoomed differently.

Z00M WINDOW

Zooms to display an area specified by two opposite corners of a rectangular window.
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Specify first corner: Specify a point (1)
Specify opposite corner: Specify a point (2)

o rd
O ) ' ()
— -
) | N\
Cy —
before ZOOM Window after ZOOM Window
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EXPERIMENT NO.9
Typical Drawing Setup
ORTHO

) Toolbar: Status bar » Ortho b

EE command entry: ortho (or 'ortho for transparent use)
Enter mode [OM/OFF] <cuwrrent=: Enter on or off, or press Enter

In the illustration, a line is drawn using Ortho mode. Point 1 is the first point specified, and point 2 is
the position of the cursor when the second point is specified.

pd 2
Ortho off Ortho on

Ortho mode is used when you specify an angle or distance by means of two points using a pointing
device. In Ortho mode, cursor movement is constrained to the horizontal or vertical direction relative
to the UCS.

Horizontal is defined as being parallel to the X axis of the UCS and vertical as being parallel to the Y
axis.

In a 3D view, ORTHO is additionally defined as being parallel to the Z axis of the UCS, and the
tooltip displays +Z or -Z for the angle depending on the direction along the Z axis

SNAP

Qb Toolbar: Status bar = Snap =

EE command entry: snap (or 'snap for transparent use)

Specify snap spacin ON/OFF/Aspect/Style/Type] <current>: Speclfy a distance, ent n optior

Oy nraso Bt I

Standard
Sets a rectangular snap grid that is parallel to the XY plane of the current UCS. X and Y spacing may
differ. Specify snap spacing or [Aspect] <current>: Specify a distance, enter a, or press EnteR

Computer Aided Structural Drawing-2 27




KCT College of Engineering and Technology Department-CE

Specifies the overall spacing of the snap grid.

Specifies the horizontal and vertical spacing of the snap grid separately.

Specify horizontal spacing <current>: Specify a distance or press Enter

Specify vertical spacing <current>: Specify a distance or press Enter

Sets an isometric snap grid, in which the snap locations are initially at 30-degree and 150-degree
angles. Isometric snap cannot have different Aspect values. The lined grid does not follow the
isometric snap grid.

Specify vertical spacing <current>: Specify a distance or press Enter

left isoplane top isoplane right isoplane

ISOPLANE determines whether the crosshairs lie in the top isometric plane (30- and 150-degree
angles), the left isoplane (90- and 150-degree angles), or the right isoplane (30- and 90-degree
angles).

Type

Specifies the snap type, polar or rectangular. This setting is also controlled by the SNAPTYPE
system variable.

Enter snap type [Polar/Grid] <current>: Enter p or g

Polar

Sets the snap to polar tracking angles that are set in the POLARANG system variable.

Sets the snap to Grid. When you specify points, the cursor snaps along vertical or horizontal grid
points.
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UNITS
Button
50 Format » Units
= units {or 'units for transparent use)

The format, precision, and other conventions to be used in displaying coordinates, distances, and
angles are set and saved in drawing template files. These settings can also be changed in the current
drawing file.

The Drawing Units dialog box is displayed.

If you enter -units at the Command prompt, options are displayed.

LIMITS

Sets and controls the limits of the grid display in the current Model or layout tab.
o] Format » Drawing Limits

B limits {or 'limits for transparent use)
Lower-Left Corner
Specifies the lower-left corner for the grid limits Specify upper right corner <current>: Specify a

upger right I

L lower left

point or press ENTER

On

Turns on limits checking. When limits checking is on, you cannot enter points outside the grid limits.
Because limits checking tests only points that you enter, portions of objects such as circles can
extend outside the grid limits.
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Off
Turns off limits checking but maintains the current values for the next time you turn on limits
checking

Ltscale
EE command entry: Itscale (or 'ltscale for transparent use)

Enter new linetype scale factor <currents: Enter a positive real value or press ENTER

Use LTSCALE to change the scale factor of Ilnetypes for all objects in a drawing. Changing the
linetype scale factor causes the drawing to be regenerated.

LTSCALE =1

LTSC ALE = 35

Text Style
Specifies the text style, which determines the appearance of the text characters. Text you create uses
the current text style.
Enter style name or [?] <current>: Enter a text style name or enter ? to list all text styles
Entering ? lists the current text styles, associated font files, height, and other parameters.
ALUT OCAD

-\_r\_r"

AUTOCAD

o) s, i BT
_,-_-.'".L | '-!-F-_-;-'x'-;-?.':if'. 2
warious styles
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EXPERIMENT NO 10

UNDO/REDO
UNDO

A

£ Command entry: undo

& 1 colbar: Standard

b L=

Enter tae humber of operatiors to Jndo or [aAuto/Contral/3EqINJEnd,/ Mark/Back]: enter 2 posit)

'ess Frtes &0 Lt .'I'Jl' ) g S I.I"—. [ .I_' =lg=Talnly

UNDO displays the command or system variable name at the Command prompt to indicate that you
have stepped past the point where the command was used

REDO
Reverses the effects of previous UNDO or U command.

(_r\‘
% Toulbar: Standard [

R) Menu: Edit > Nodo

Shortcut menu: With no comrrands active anc ro objec:s selected, right-click in the drawing area and

choose Redo,

@ Command entry: redo

REDO reverses the effects of a single UNDO or U command. REDO must immediately follow the U
or UNDO command.
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EXPERIMENT NO.11
PLOT COMMAND

—

Button

£ ribbon: Output tab > Plot panel » Plot
R Menu: Application menu » Print > Plot
£ Toolbar: Standard
Shortcut menu: Right-click the Model tab or a layout tab and click Plot.

@ Command entry: plDt

Summary

The Plot dialog box is displayed. Click OK to begin plotting with the current settings.

If you enter -plot at the Command prompt, options are displ
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